
Route1                    (version 2.1a)

Route 1 provides efficient access to your most important and frequently used 
applications and tools.    Choose one of the following topics for instructions and explanations 
of Route1's many powerful features.

Why use Route1?
Getting Started:    Installation
How Do I...
What Is...
Hints and Suggestions
About Route1



Why use Route1?
The Windows desktop is where you do all your work in Windows, but it is not efficient 

if you have to open and close several applications to get your job done.    To run an 
application, you have to wait while Program Manager loads each group, search for the icon 
that starts your program, and it's icon, and then wonder why ProgMan doesn't give you back
your memory when you close the group.    Windows 3.1 is an improvement, but it's not 
enough if you rely on your machine to get your work done.    Route 1 treats your desktop as 
a automobile dashboard, able to start programs and issue commands with the simple click of
a button.

Route 1 assembles your programs in a fast, small, organized button bar on the right 
side of your screen.    It is fully configurable, contains a built-in clock & calendar, can run 
complex scripts and commands, and can launch and take control of any program.

Route1 takes up less memory than when you open a 3.0 group with over 15 icons in 
it, and since it's always within reach, it's much faster.    It's easier to configure than Program 
Manager, because of the quick, visual setup.    Route1 is not meant to replace Program 
Manager, only to supplement it; although you will find yourself using ProgMan much less 
every day.    (Plans are in the works to make Route1 usable as the "Shell")    Put your ten or 
eleven favorite and most commonly used programs in Route1, and it will soon become 
indispensable.

Route1 is shareware - if you like it, it costs only $14.00 (send to address below).    
Registration will entitle you to free technical support with Route1 and free updates of 
Route1.    Such a Deal!    If you think that Route1 is either useful, well designed, and 
innovative, or just a nuisance, please drop me a line, so I know how far it has traveled.    
Thank You.

Dave Karp
P.O. Box 20024
Oakland, CA    94620
Internet Address:

                                          Daaron@OCF.Berkeley.EDU



Getting Started:    Installation
If you are new to Route1:

1.    "Run" the install application from the Route 1 installation disk.
2.    Double click on the Route 1 icon to start it.

or
1.    Copy the 68 included files to any directory you wish, preferably to their own 

directory.    They can be in any directory actually, as long as all of the files are present and 
together.

2.    Add Route 1 to a Windows 3.x group, as you would any other new application.

If you are a Route1 user before version 2.0:
1.    Proceed as above.    Your old Route1.INI is unfortunately incompatible with version

2.1.

If you are a Route1 version 2.0 user:
1.    Copy all of the files, except Route1.INI to your Route1 directory.    Your Route1.INI 

is
compatible with version 2.1

To start Route1 automatically when Windows 3.x is loaded:
Add Route1 to WIN.INI to load up every time you start Windows by adding the full 

path and filename (d:\path\Route1.EXE) to the end of the line that begins: "Load = ".    
Putting Route 1 in the next line, the one starting with "Run = ", will have the same effect, 
but Program Manager will start up as an icon (minimized).    

This is the sixth½ release, and I have all of the known bugs ironed out.    However, I 
have added many new features since version 2.0, as well as enhancements, and bug fixes.    
If(when) any more bugs are found, they will be fixed and released as version 2.1b, or 
something like that.

A maximum of 40 icons is allowed.    This is because having any more than 40 icons 
not only defeats the purpose of the program, but also won't fit on the largest panning 
screens (1280 x 2048).    Lower resolutions will be able to fit fewer, but Route 1 will always 
allow 40.    If they go off the screen, you can use something like BigDesk, which creates a 
virtual desktop four times the current size.    With this, of course, Route 1 is fully compatible.  
If a program like BigDesk moves Route1, then simply press the Control Button to place it 
back in the upper-right corner of the screen.

All functions and options are operational, and there is no registered version.    I wrote 
this for myself, friends, and anyone who likes it.    If you like it and use it, a small contribution
of $14.00 would be greatly appreciated, and would also guarantee that you would receive 
free technical support with Route1 and free updates of the program.    Such a deal!

Instead of a registered version, users are asked to comment on Route1's features and
performance.    Any suggestions might be incorporated into the next release of Route1; I'm 
always looking for new ideas.    Send me your icons, too!

To get you started, there are 10 configured icons, and a small, blank button on top.    
Click on the uppermost button to access the menu.    It's that simple.    There are fifty or so 
hand drawn icons included with this release, all made for Route1.    Some of them are 
obviously for use with specific commercial packages, like Excel, WordPerfect, Lotus 123, and 
Amì Pro.    Their inclusion with Route1 is only for use with the appropriate package.    My 
advice is to try all the options to see how they work.    I think everything is pretty much self 
explanatory, but I have included this help file anyway.    However, there is another, quicker 
and simpler help system built in to Route1.    Just press the little [?] on the button bar, and 
then press any button; it will tell you briefly what each icon in the icon bar does, in case you 
forget.

There is a built in configuration editor, but there's no reason you can't edit Route1.INI



yourself; as long as you have some reasonable idea of what you're doing.    If you screw up, 
just delete or rename the file, and Route1 will create a new Route1.INI file identical to the 
one that came with it.

Route1 is shareware - if you like it, please send $14.00 to the address below.    
Registration will entitle you to free technical support with Route1 and free updates of 
Route1.    Simply print out the included order form (orderfrm.wri) with Windows Write, and fill
it out.    If you think that Route1 is either useful, well designed, and innovative, or just a 
nuisance, please drop me a line, so I know how far it has traveled.    Thank You.

Dave Karp
P.O. Box 20024
Oakland, CA    94620
Internet Address:

                                          Daaron@OCF.Berkeley.EDU

Troubleshooting:

Unrecoverable Application Errors:    If you receive UAE's with Route1, chances are that
your DOS environment is too small, or you haven't allocated enough file handles.    To change
the DOS environment to 512 bytes, add the following line to CONFIG.SYS:

DEVICE = C:\COMMAND.COM /P /E:512

To increase the number of file handles, either edit or add the following line:

FILES = 80

The more files, the better, although more files take up a little more memory.    If you have a 
third party memory manager, you can load the files high, and have as many as you want.    
Every open EXE file, ProgMan group, font, open text file, etc. takes up file handles.

Other than that, make sure your hard disk is optimized and not fragmented.



How Do I...
Create a New Button
Edit / Move / Delete a Button
Launch a Program
Create a SubMenu
Create / Edit a Script
Change Settings
Create / Run StartUp Script



What Is...
Menu Item
ButtonBar Item
Route1 Settings
Scripts (*.RS1)
Script Commands
Command Line Parameters
Command Syntax



About Route1
This program was inspired by the following two things.    First, I was browsing through 

a NeXT brochure, and thought the vertical icon bar was cool.    I played around with some of 
the capabilities of Visual Basic and Windows to see what something like that would look like. 
Second, after I had released Route1 v1.0, I saw AppDock by David Black on a local BBS, but I
didn't like it very much, and I thought the idea could be taken much further.    Later, after 
finishing 2.0, and while writing this help file, I saw AppBar, a much simpler implementation 
of this Idea.    Route 1 is meant to be more than just a menu.    Version 2.1 adds even more 
features and power to the classic Route1.

Route1 was written in Visual Basic (by Microsoft) with Windows 3.0, and Windows 3.1. 
This help system was created with Xantippe (by IRIS Media Systems), and most of the icons 
were drawn with Icon Magic (by Steve Stedman and Jeff Ayars).    All of the included icons are
either my own design, or my alterations of icons from commercial software and public 
domain icon libraries.

Although it has been tested on several machines and situations, I can't guarantee 
everything, so please contact me if you encounter a problem, and I will do everything I can 
to fix it.

Route1 is shareware - if you like it, please send $14.00, with the included order form,
to the address below.    Your registration gets you free updates, and free technical support 
with Route1.    If you think that Route1 is either useful, well designed, and innovative, or just 
a nuisance, please drop me a line, so I know how far it has traveled.    Thank You.

Dave Karp
P.O. Box 20024
Oakland, CA    94620
Internet Address:

                                          Daaron@OCF.Berkeley.EDU

Release Notes:

v1.00 - The birth of a legend - hee hee hee!

v1.01 - This version differs from the original v1.00, mostly from bug fixes.    I think I got 
them all, but I'm sure I'll find more.    When I do, you'll see another release.    Other than that,
were some superficial changes to streamline the functionality of the program, and make it 
more "perfect" - Ha, Ha.

v1.02 - Killed more bugs, and I didn't even use Raid.

v1.10 - More Bug fixes.    Altered icon bar to make pressing an icon more realistic.

v1.20 - One or two bugs needed dealing with, and a couple of operations needed to be a bit 
faster or more efficient.

v2.00 - I fixed a few small, annoying bugs, and added the following features:
1.    Sculptured dialog boxes
2.    More icons included, and more allowed on screen
3.    Better error handling
4.    Buttons move when pushed
5.    SubMenu support (see above)
6.    More intelligent memory management
7.    Better handling of low resolution displays (640x480, etc.)
8.    StartUp Script to replace WIN.INI's limited 'LOAD=' command



9.    Hypertext help system in windows format (what you're looking at)
10.    You can now move buttons on the bar with Edit.
11.    It's faster, and more arrow-dynamic!

v2.10 - I have added the following conveniences and fixes:
1.    Digital clock/calendar option
2.    More efficient & error-free
3.    Fixed an obnoxious quirk with small buttons on low-resolution displays
4.    Fixed bug that screwed up Route1.INI when a SubMenu was changed
5.    Now includes a script editor, tester, and interpreter.
6.    StartUp function has been moved to the script editor
7.    Will re-position itself when moved by another application
8.    Better, longer, more comprehensive help file with better hot-links
9.    More informative and infrequent error messages
10.    Now allows up to forty (40) buttons at a time
11.    Allows multiple (infinitely many) configuration files (*.INI)
12.    Improved functionality of SubMenus, Program Launch, Options Box, and other 

dialog boxes
13.    Faster, easier Exit button - will bypass Program Manager's "Exit Windows?" 

prompt
14.    Eliminated shell configuration
15.    New "About" box - double click on shield for something new...
16.    More shortcuts, like dragging buttons, and double-clicking on objects to edit 

them.
17.    Will automatically back up Route1.INI when it is saved as Route1.BK1
18.    An installation utility is now included.

v2.1a - eradicated a few bugs concerning scripts, the install utility, and an incorrect 
statement made in this documentation.

These additions have undoubtedly brought on some new bugs, most of which I've 
found, and taken care of, but you never know.

Future -    I plan to allow Route1 to work with File Manager and Disk Jockey, so that you can 
drag/drop a file or icon onto the button bar.    I might include an undo facility, that would 
remember the last 10 or 15 cut/paste operations and allow selective recall.    I might give 
Route 1 the ability to monitor other applications, the Clipboard, DDE, and OLE.    Wow - I'll 
give it a voice and a personality to start leading your life for you!    Well...    If I hear enough 
comments or suggestions about something - odds are I'd do It.

Possible Future Additions:
1.    Drag - drop with File Manager
2.    Scheduler to run scripts at certain times
3.    Hotkey support
4.    Allow multiple columns (maybe)
5.    Will run files other than EXE, COM, BAT, PIF, and RS1 types; those with 

associations
6.    Will be able to extract icons from and store icons in EXE, DLL, ICL, and ZIP files
7.    Will be able to convert icons to 3D buttons for Route1
8.    ?

Legal stuff, artistic and scientific excuses, and other ramblings:

First of all, of any harm should come to your system or files while Route 1 is installed, 
I take no responsibility.    Don't panic - Route 1 is safe . . . as long as you use protection . . .

Although some of the included icons are derivatives or enhancements of commercial 



program icons, it is not my intention to distribute any material that its creator(s) or legal 
owner(s) would object to.    I will immediately remove, or alter to their satisfaction, any 
icon(s) which is brought to my attention as proprietary in nature and should not be freely 
distributed.    The design, look, and feel of all the different parts of my program is either 
purely of my own invention, or a thorough alteration and combining of what I wished many 
other programs should be.    It is also not my intention, to mimic, or to lessen the 
effectiveness of any other software in existence. I wrote this program originally for my own 
use, and am distributing it for other people to use strictly for my own satisfaction of making 
something that someone else finds useful, or even necessary.    If you use Route1 for 
anything more than to take up disk space, you are morally obligated to pay for it; just 
$14.00 gets you free technical support, free updates, and a clear conscience.    Just fill out 
the order form (orderfrm.wri), and send it to the above address.

If you are registered, and you find a bug, and I am able to fix it, I will do so as quickly 
as possible, and will send you the fixed version in the mail - no charge.

Other works by the same author:

MS/2 - VGA menu system for DOS - icons, pull-down menus, screen saver, calculator,
auto-dialer, tetris clone all built in.

Disk Jockey* - XTree-like file manager for Windows - contains every conceivable 
function, uses left and right mouse buttons, and is fast, pretty, and powerful.

Six-Pack - A collection of desktop utilities for Windows, including a clock, calendar, 
timer, memory display, font viewer, text editor, system monitor, and key finder all in colorful
tool bar.

Impasse* - puzzle/maze game for Windows - detailed, colorful graphics, brain-
twisting puzzles, and a cute little bird.

Contents - a small program to display the contents of any directory - allows file 
delete and edit - more useful than it sounds.

ColorBar - useful, informative color control utility for Windows Programmers.
Windexit - the fastest, cleanest, smallest, easiest way to exit Windows.
Make Your Day* - automated, versatile schedule maker for Windows.

( *available Summer, 1992)



Create / Run StartUp Script
The second line of WIN.INI begins with "LOAD = ".    What follows is a list of programs 

that are loaded when Windows is first started.    The inherent problems with this method are 
as follows:

1. You are limited to 127 characters for all programs.    This is enough room for three or four 
programs.    If you have After Dark, Clock, and of course, Route1 on this line, you probably 
can't fit any more.

2. You can't have any command-line parameters.    If you start a program with Program 
Manager, like Word for Windows, you can have it automatically load a document by typing: 
WINWORD myfile.DOC.    WIN.INI won't allow for this either.

3. You have to edit WIN.INI manually, and risk screwing up something else.

4. Windows 3.1 tries to fix this problem, but is still pretty messy, and takes up more memory.

Route1 2.1 has a built in function that eliminates all this hassle.    Following the same 
powerful, simple, straight-forward command conventions as Route1 buttons, SubMenus and 
scripts, you can quickly create a StartUp Script.    Simply create a script, and call it 
StartUp.RS1.    Then open the Options box, and turn "Run StartUp Script" on.    The script will 
then be run automatically, when Windows starts and Route1 is loaded.



Change Settings
Open Route1's menu by clicking on the top-most button of the ButtonBar, and select 

Options from the Configure menu.
These are four settings that you can change:

Single/Double Click:    Choose what you would like to use to press a button on the 
button bar.    Single- clicking is faster, but double- clicking prevents accidental activation.

Command Line Parameter:    Turn this on if Route1 should ask for additional 
command line switches when you press a configured button on the ButtonBar.

Clock Style:    This toggles between the analog (circular) clock and the digital clock &
calendar.    Click on the clock button to change the time, or on the calendar to change the 
date.

Run StartUp.RS1?:    Turn this on if you want Route 1 to run the StartUp Script when
Windows is loaded.

Screen Scaling:    Route1 was written on a 1024x768 Windows screen, but it will 
work on any resolution.    On lower resolutions, or with different screen drivers, text on some 
windows and dialog boxes might not be visible.    Adjust this parameter to suit your particular
system.

Configuration File:    This feature allows you to have more than one button bar, and 
more than one collection of settings.    You will see a list all of the files in the Route 1 
directory that can be used as the configuration file.    Route1.INI is the default, but simply 
click on another filename to use it.    To make a new file, press the "Create New..." button, 
and you will be asked for a name for the new file.    Any Route1 configuration file must begin 
with "R", and have the extension ".INI".    The new file will then be made the current 
configuration file.    See Command Line Parameters for information on more permanent 
settings.



Create / Edit a Script
A script (with the extension *.RS1) is a collection of commands, that can be run by 

Route1.    The commands are executed sequentially, and can be assigned to a button or 
SubMenu, or can be launched by Route1.

To create or edit a script, select Apps from the Configure menu.    Press the "Script 
Editor..." button.    A small window appears, allowing you to pick an existing script to edit 
(by pressing Edit Script), or to create a new script (by pressing New Script).

Once the editor is visible, you can type in any valid commands, one on each line.    
You can have as many commands as you wish, as long as the script file's size does not 
exceed 32,768 bytes.    See Script Commands for a list and explanations of valid commands.  
Commands can be entered either by typing them, or by pressing a corresponding button.    
Pressing the button will automatically enter a command in the correct syntax, allowing you 
to enter in the specifics.    You will be prompted for certain parameters when applicable.

You can test your script by selecting Test Script from the Edit menu.    This will run 
the script, allowing you to follow along in the text window.

When you are done, select Save from the File menu.    Select Cancel to exit the 
editor without saving, or No Change if you are editing an existing script.

To assign a script to a button or SubMenu, simply select any *.RS1 script file in the 
Route1 directory with Browse.    To run a script file, either press the button that you have 
assigned to it, select the menu item that you have assigned to it, or Launch it.

You can not run a script from another script file.



Create a SubMenu
A SubMenu is a collection of programs, applications, or utilities that you feel all 

belong together.    They are displayed in a standard menu format, similar to a conventional 
Windows menu, except that you configure them how you want to.    To find out how, select 
How Do I..., and Create SubMenu.

When a SubMenu is displayed, select the desired item from the list, or press the small
red close button at the top-left of the menu to close it and return access to the ButtonBar.

Proceed as though you were going to add or edit a button.    When the dialog box 
appears asking for the command string, enter in a name for the SubMenu you wish to 
create, surrounded by brackets: [ ].

        Example:    [Tools] 

Press Accept to begin to enter in individual items for the SubMenu.    A text box will appear, 
allowing entry of as many menu items as you wish.    The format for entries is as follows:    
Entry names are in brackets [], and their corresponding Command strings follow.

        Example:
          [NotePad]>C:\WINDOWS|NOTEPAD.EXE
          [Calc]>C:\WINDOWS|CALC.EXE

Command strings follow the same conventions used to create a button.    If you select Add 
Program from the File menu, Route1 will automatically insert the appropriate commands 
after asking you to show the location of the EXE file and type in the menu item name.

When you're done adding programs, select Save from the File menu to accept your 
entries.    Press Cancel to throw away your changes.    You are then asked to choose an Icon, 
and the location for your button, which is accomplished in the same manor as to Edit / Move 
a Button.

To edit an existing SubMenu, press Edit Item, and proceed as described above, or 
double-click on the title-bar of a displayed SubMenu.

To use a SubMenu, simply press the button that you have associated with it, and 
select a menu item in the list.    Press the small, red button on the top-left of the SubMenu to 
close it.



Launch a Program
If you have configured Route1's ButtonBar to include the four function buttons, then 

you can quickly and easily launch any EXE, COM, PIF, BAT program, or RS1 script file.
Just press the left arrow in the function buttons to open a dialog box.    Here, browse 

your hard disk's directories for the desired program, select it, and press Launch.    By 
default, EXE, COM, PIF, BAT, and RS1 files will be displayed, but if you change the box that 
reads "*.EXE" to something else, the appropriate files will be displayed.    When you click on 
a file, its name is displayed in the text box, where you can add any applicable command line 
parameters.

Another way to launch a program is to create a launch button.    This is done by 
adding a button with an icon, but nothing for the command string.    Just leave it blank, and 
Route1 will launch any program by pressing the button.



Edit / Move / Delete a Button
To edit a button on the button bar, select Apps from the Configure menu.    Select 

the button to edit, either by choosing it's icon name from the icon drop-down list box, or by 
choosing it's application from the application drop-down list box.    Press Edit App.    You are 
now able to change any properties of the button, such as it's position, its icon, and its 
application.

To remove a button, first select the button, either by choosing it's icon name from the
icon drop-down list box, or by choosing it's application from the application drop-down list 
box.    Press Delete App to remove it.

To move a button, just drag it with the right mouse button where ever you want in 
the button bar.    You can also, press Edit App, and change it's position number.    See 
shortcuts for more.

To quickly edit a button, either click on it with the left and right mouse buttons 
simultaneously, or drag the button into the ControlButton with the right mouse button.

You can not edit the clock, or the function buttons.
After pressing Accept to save your changes, or Cancel to ignore them, press 

Continue to use Route1 normally.



Create a New Button
Open Route1's menu by clicking on the top-most button of the ButtonBar, and select 

Apps from the Configure menu.
To add an application and corresponding button to the button bar, start by pressing 

Add Item...    A dialog box appears, allowing you to enter in a filename, list of filenames, or 
commands.    You are now able to type in a string of as many commands as you wish, 
separated by a "|".    If you do not want to enter any commands, press Browse, find an EXE 
(or COM, BAT, PIF, RS1) file on your hard disk, press Accept, and Route1 will include all 
necessary commands.    When you're done, press Accept.

You can now select an Icon to be used as a button in the button bar.    There are about
50 included icons, hand-drawn for Route1, and you can add your own, as well.    Any 
Windows 3.x icon will work, but if it follows the conventions of the many icons included with 
Route1, it will look infinitely better.    A blank button, called BLANK.ICO is included, so that 
using any icon editor (I recommend Icon Magic) you can create your own.    Any icon you use 
must be in the Route1 directory.    If you don't like or use the 3-D convention, invent one of 
your own.    For instance, using plain icons may provide a little more area on each button.    
The choice is yours.    After selecting an appropriate icon, press Accept.

The last thing to do is to configure is the new button's placement in the ButtonBar.    
You can choose any number between 1 and the total number of buttons (including the new 
one).    1 will put it at the top, and the highest number will put it at the bottom.    Use the 
visible, existing bar for guidance.    

Your attention is returned to the Configure Application dialog box.    If you're done, 
press Accept to save your changes, or Cancel to throw them away.

If you want to edit or remove an application, select the desired one from the left 
dropdown-list box, or select the desired icon from the right dropdown-list box.    Press 
Remove Item to remove the selected button.

See also Edit / Move a Button.
After pressing Accept to save your changes, or Cancel to ignore them, press 

Continue to use Route1 normally.



Command Syntax
Not to be confused with script commands, Route1 commands are used to start an 

application from a button, in the StartUp script, in SubMenus, and when launching a 
program.    The commands are used to separate other commands and filenames, and to 
change the current drive and directory.    When you add/edit a button, and press Browse, 
Route1 will automatically insert the commands necessary to load and enter an application.

There are two special characters associated with Route1 commands.    The first one is 
"|", and the other one is ">".    They are used as follows:

| is used to separate commands:

        NOTEPAD.EXE|CALC.EXE|CARDFILE.EXE

        Here, the three applications are loaded in order, all with the click of one button on the 
bar.

> is used to change the current directory:

        >C:\WINDOWS\ROUTE1

This will change to the Route1 directory (if that is what it is).

Using Browse, and selecting NOTEPAD.EXE in the Windows directory will produce the 
following:

        >C:\WINDOWS|NOTEPAD.EXE

This is how to load all programs in Route1, and constitutes a simple batch language, but for 
more complex operations, the new script editor and interpreter can launch (with the same 
commands) and control other applications, as well as accept text input, and run Windows 
macros.    See Creating a Script for more.



Command Line Parameters
Command Line Parameters are codes placed after a programs filename to specify 

special options.    For instance, in DOS, typing "WIN /3" will start Windows in 386 Enhanced 
mode, while "WIN /S" will start Windows in Standard Mode.    The /3 and /S are command line 
parameters.    By the way, typing "WIN :" will start Windows without displaying the blue 
opening screen.

Route 1 has three command line parameters.    If, for some reason, Route 1 cannot 
find Route1.INI, or any of it's icons, include the following parameter:

ROUTE1.EXE    Path={path}

Substitute {path} with the directory name that contains Route1.    There should be no spaces
around the equals sign.    The default is the path where Route1.EXE is located.    All of the 
Route1 files, icons and scripts should be together in their own directory.

If you want to load Route1 without loading all the programs in the StartUp Script, 
include the following parameter:

ROUTE1.EXE    NoStart

The default is whatever the StartUp switch in Settings Options is set to.

To use a configuration file other than Route1.INI, include the following parameter:

ROUTE1.EXE INI={ini name}

where {ini name} is the name of the configuration file you wish to use.    The file's name 
must start with an "R", and have the extension ".INI".    To change the active configuration 
file while running Route 1, see Change Route 1 Settings.



Script Commands
The following commands can be placed in a script in any order to perform various 

tasks.    See Create / Edit a Script for more information.    See Script Hints for ideas. These 
commands can be typed in normally, or can be entered automatically by pressing the 
corresponding button on the command button bar.    Every line in a script must be a valid 
command, comment, variable declaration, label, or blank space.    Any line beginning with a 
space, such as that which has been indented will be treated like blank line, and ignored.    
The following are valid commands:

Browse...
>Ask & >Input
>Goto
>Type
>Wait
>If & If Exist
>Beep

All of these commands work with variables, which are designated by %n, where n is a
whole number, ranging from 0 to 9.    Variables can contain anything, such as text or 
numerical values.    Variables can be assigned by either the Input command, or with an 
equals sign:

%1=3 (assigns the numerical value of 3 to the variable %1)
%4=+2 (adds 2 to the current value of %4)
%3=-2 (assigns -2 to %3)
%6=+-2 (subtracts 2 from the current value of %6)
%2="Howdy" (assigns the text "Howdy" to %2)
%2=+" Doody" (adds " Doody" to %2 to make "Howdy Doody")

Variables can be put in place of anything, for example:

Wait(%3)

Any comments you wish to include in your scripts should start with ' or ; or *.    These 
comments are for the script writer's use, and will be ignored when the script is executed.



Scripts (*.RS1)
A script (with the extension *.RS1) is a collection of commands, that can be run by 

Route1.    The commands are executed sequentially, and can be assigned to a button or 
SubMenu, or can be launched by Route1.    See Create / Edit a Script for more information.

Scripts can perform complex operations, simple math, and can be interactive or run 
in the background.    See Script Hints for ideas and possible applications.



Route1 Settings
Route1 can be configured in almost every way.    Any button on the button bar can be 

created, moved, removed, or changed.    The settings, or options, describe the other ways 
that Route1 behaves and looks.    Your best bet is to try them all out, and see what settings 
work best for you.    See Change Settings for more detail.



ButtonBar Item
Four Function Buttons

The Function Buttons is a button, built into Route 1 (like the clock), that provides four 
features, also built into Route 1.    The Function Buttons are enabled when you first get Route
1.    

The buttons are used as follows:

[<]    Launch a program

[ ^ ]    Collapse Route 1, so that only the ControlButton is visible.    Press the 
ControlButton to restore Route1.

[?]    Press this, and then press any button on the bar to find out what it does.    
Pressing a configurable button displays what you have assigned it to do.    Pressing the 
function buttons will remind you of what they do.

[EXIT]    This exits Windows, and returns to DOS instantly, without asking.

If you don't have the function buttons configured on your ButtonBar, open the 
Configure App box by selecting Apps from the Config menu.    Press Add App, and 
>Buttons.    Specify where on the ButtonBar you want the buttons, and press Accept.    If 
you want to remove the function buttons, select Apps from the Config menu, choose 
"1Buttons" from the App list box, and press Remove App.    Use the right mouse button to 
move the function buttons anywhere on the button bar.    That's It!

Clock
The clock is a button, built into Route 1 (like the function buttons), that like most 

clocks, displays the current time on your screen.    To change the system time, just press the 
clock button.    If you have chosen the digital clock, the date is also displayed, and the date 
can be set by clicking on the calendar portion of the button.    The clock can be deleted like 
any other button, but not edited.    The Clock is enabled when you first get Route 1.    If you 
don't have the clock configured on your ButtonBar, open the Configure App box by selecting 
Apps from the Config menu.    Press Add App, and >Clock.    Specify where on the 
ButtonBar you want the clock, and press Accept.    If you want to remove the clock, select 
Apps from the Config menu, choose "1Clock" from the App list box, and press Remove 
App.    If you wish to change the analog clock to the digital clock/calendar, or vice-versa, 
select Options from the Config menu, and click on the clock style switch.    Use the right 
mouse button to move the clock anywhere on the button bar.    That's It!

Top (Control) Button

The Control Button is the top, small, blank button on the top of the ButtonBar.    Press 
it to use the Menu, to restore the bar if it has been collapsed by the collapse function button,
or to re-position Route1 if another program has misplaced it.    Edit any button by dragging it 
with the right mouse button into the Control Button.

Application (User-Defined) Buttons

The majority of buttons on the bar are ones that you configure yourself to start 
programs, change directories, open SubMenus, run scripts, launch programs, or whatever.    
See Getting Started: Installation and Create a New Button for more.





Menu Item
Cancel / Continue

When the menu is first displayed by pressing the ControlButton, the last menu item is
Cancel.    Press it to hide the menu and return to normal use.    If, however, you do not press 
Cancel, and use instead the help, configure, or about features, the Cancel will be changed 
to Continue, to allow you to continue with normal use; basically having the same effect as 
Cancel.

[?] - Help Access

This provides access to this help file (ROUTE1.HLP).    Additionally, there is a [?] button in 
almost every dialog box which can access this file.    However, it is not yet context-sensitive; 
in other words, no matter where you are, you'll see the Index first.    This will be hopefully be 
fixed in the next update of Route1.

Config:    Apps

Selecting Apps from the Config menu will display a box allowing you to Add, Edit, 
and Delete any buttons on the button bar.    You can also specify the script that is executed 
when Route 1 is loaded normally, and without the NoStart parameter. (See command-line 
parameters)    Pressing Accept will automatically save any changes that you have made, 
and Cancel will, of course, forget them.    This window shows the total number of configured 
buttons on your ButtonBar, and allows you Add a new button, or select any one of them to 
be Edited or Deleted by selecting it's command or icon name.    Pressing [?] will show this 
help file.    Using this dialog box and the Options box eliminates any need to edit Route1.INI 
manually.

Config:    Options

Selecting Options from the Config menu will display a box allowing you to change 
any of Route 1's settings.    Using this dialog box and the Apps box eliminates any need to 
edit Route1.INI manually.    Pressing Accept will automatically save any changes that you 
have made, and Cancel will, of course, forget them.    Pressing [?] will show this help file.    
The configurable options include the clock style, default system shell, and other preferences.

System:    Exit

This exits Route1, and unloads it from memory completely.    Any applications that 
were started with the StartUp Script, or from one of the buttons are not affected in any 
way, except to give them a little more memory.    This does not exit Windows, unless Route1 
is the designated system shell.



>Beep
Purpose:    makes a beep.

Syntax:    Beep

Remarks:    use this to alert the user that something is going to happen, or something has 
already happened.    If you use beep in conjunction with Ask or Input, place the beep first; 
otherwise the beep will not sound until the user has done something.



>If & If Exist
Purpose:    decides whether or not to execute a particular command depending on a 
situation

Syntax:    If %n="expression" then command
or

    If Exist "filename" then command

where n is a whole number ranging from 0 to 9, signifying a variable.
where expression is whatever you %n might be equal to.
where command is any valid script command.
where filename is any valid file name, including its path.

Remarks:    for the first situation, command will be executed if and only if the variable (%n) 
is exactly equivalent to expression, whether expression is text, or a number.    In the second 
situation, command will be executed if and only if filename exists.



>Wait
Purpose:    pauses script execution for a specified amount of time

Syntax:    Wait(n)

where n is any number greater than 0, representing seconds

Remarks:    use this to wait n seconds while a program loads before executing the next 
command.    Wait does not affect other running applications.



>Type
Purpose:    sends keystrokes to the active Windows application, as though they were typed 
from the keyboard

Syntax:    Type"expression"

where expression is any valid keystrokes to type.

Remarks:    If used correctly and carefully, this command can take control of any Windows 
application.    It can not type keys to a non-Windows application.    Expression can consist of 
anything, except a few reserved characters:

+      for    SHIFT
^        for    CONTROL
%    for ALT

Use these symbols with others, such as ^J would send Ctrl-J.    To use these characters 
normally, enclose them in parenthesis, such as {%}.    If you use the >Type button, you are 
given a large list of some possible special combinations.



>Goto
Purpose:    transfers execution of the script to another location

Syntax:    Goto label

where label is a word designated elsewhere as a label by ending it with :

Remarks:    use Goto to repeat or skip any portion of the script.    A label can be any word 
that does not start with B, A, I, T, W, or G.    Label should not contain a colon (:) after Goto, 
but should when it is the actual label:

. (here are normal commands to be executed)

.
Goto Skip
. (this portion will be ignored)
.
Skip:
.
. (these commands are executed)



>Ask & Input
Purpose:    prompts the user to continue, cancel, or enter data.

Syntax:    Ask"text"
or

    Input(%n)"text"

where text is a line of text to be displayed to the user
where n is a number ranging from 1 to 9, signifying a variable.

Remarks:    These two commands allow the user to interact with the running script.    Ask 
displays text, with two buttons:    Ok and Cancel.    Pressing Ok will continue the script, and 
pressing Cancel will abort the script.    Input works the same way, but allows the user to 
input data as well.    Pressing Ok will continue the script, while assigning whatever was 
entered to the variable %n, and pressing Cancel will abort the script.



Browse...
Purpose:    Allows the script writer to browse the hard disk in order to insert a command to 
start an application

Output Syntax:    >path|appname

where path is any existing drive and directory
where appname is the name of an existing application to load

Remarks:    this button works in the same way that the Browse button works when you Add 
or Edit a Button, such that the appropriate command is entered for you when you select a 
file to run from its directory.



Hints and Suggestions
Shortcuts
SubMenus and Scripts



Hints: SubMenus and Scripts
SubMenus:

1.    If you have a small, or large collection of tools and utilities, a good way to keep 
track of them is to put them all in a SubMenu.    Then select a more general-styled icon, such
as the toolbox, or the hammer.

2.    If you find yourself constantly editing, or viewing the same group of files, put 
their filenames (following the application's name) in a SubMenu, with the application's icon 
for the button.    Just press the button, and choose the file.    The application will be loaded, 
and your file will be displayed - instantly!

3.    A good application of SubMenus is for a communications package, like Crosstalk.   
If you only regularly call a small group of numbers, put their names in a SubMenu under a 
communications icon, and have the SubMenu call the appropriate file, or Xtalk script.    Then 
just press the button, and select the name, and the settings will be loaded, and the number 
will be dialed for you.

Examples:
[Library]XTALK.EXE library.xwp
[BBS #1]XTALK.EXE bbs1.xwp
[BBS #2]XTALK.EXE bbs2.xwp
[Compuserve]XTALK.EXE cserve.xwp
[...other]XTALK.EXE

Scripts:
1.    Scripts are good for performing tasks that you do regularly.    Either program a 

script to do it for you, or make a Windows macro, and have a Route1 script call it with the 
Type command.    

2.    If you use File Manager, you might be annoyed at the fact that there is no way to 
have it display the entire disk upon startup.    You either have to press a combination of keys,
or select an item from the menu.    Instead of this, make a script that opens FileMan, waits a 
few seconds, and then types "^*".    This will force FileMan to behave the way you want.

3.    There is no limit to what you can do with scripts and a few minutes.    A sample 
script, Timer.RS1 is included, which demonstrates a count-down timer.    Send me your 
scripts, and I might include them in the next release of Route1.

Route1:
1.    If you wish to make Route1 the shell, instead of Program Manager, or Norton's 

Quick Access, here's how you do it.    Route1 does not have the ability to act as the system 
shell, although it is able to exit Windows.    To work around this, simply choose a small utility 
or tool that you already use, such as Andy Wilks' DogCow, I. Heath's BigDesk, or Sonam 
Gyato's SizeIt, and make it the system shell by editing the line SHELL=ProgMan.EXE in 
SYSTEM.INI.    Replace ProgMan with whatever you choose.    Then, include Route1 in the 
Load= or Run= lines in WIN.INI.    This will virtually make Route1 the system shell, without 
having another shell that you no longer use taking up resources.

2.    Route1 can have several configuration files that can be easily switched by 
selecting one in the options menu.    If you find yourself switching INI files frequently, try 
making a couple of simple scripts that, using the Type command, will control Route1, and 
change the INI file for you.    Then just assign one or more of these INI-changing scripts to a 
button or SubMenu, and switch files quickly and easily.

3.    If you have discovered or invented any shortcuts of your own, send them in to 
me, and I might include them in the next release of Route1.    Thank you for your support.



Shortcuts
Button Bar:

1.    Buttons can be moved by going through the menu, pressing Edit App, and 
changing the number that defines the position of a button in the button bar.    Route1 version
2.1 adds the convenience of Drag-Drop to the bar.    Just press and hold the right mouse 
button on any button, and drag it to any new location on the bar.    It's that simple!

2.    Buttons can also be edited without going through menus and dialog boxes.    
Either drag a button into the Control Button(on top), or click on the button with both the left 
and right mouse buttons to edit the button.

3.    To quickly edit the contents of a SubMenu, just open the SubMenu, and double-
click on it's title bar.

4.    To automate repetitive processes, create a script to do them for you, or create a 
script that calls a Windows macro to do them for you.    You'll never know how much time 
you'll save by spending just a few minutes with the Script Editor.

5.    If you find yourself constantly editing or viewing the same group of files, put their
filenames (following the application's name) in a SubMenu, with the application's icon for the
button.    Just press the button, and choose the file.    The application will be loaded, and your 
file will be displayed - instantly!

That's all.    If you have discovered or invented any time saving devices with Route1, please 
send them to me, and I might include them in the next release of Route1.    Thank you for 
your support.




